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ABOITMCOLONEL'SBEQUEST

The COLONEL’S BEQUEST is different from many
adventure games. It can best be described as an

interactive play in 8 acts. You will play the entire game
in one location, on an isolated island in a bayou. Events

can take place throughout that locale at any time during

the game, and they may occur whether you are present

or not.

At the end of each Act. a clock will appear on your

screen and strike the hour. It will also appear at other

intervals during the game. Take note of the events

which cause this to happen, and your location at the

time it occurs, as this will help you to keep track of your

progress. Being in the right place at the right time can

be invaluable.

Also, if you have thoroughly explored a room, don’t

assume that the next time you visit the room things will

be the same. While you are exploring another area,

someone else may enter the room and leave a valuable

clue for you to find!
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CAST OF CHARACTERS

Colonel Henri Dijon

Ijiura is a 20 year old
journalism major al

Tulune University in

New Orleans. A l920‘s
ingenue, she's studious
and down to earth,

energetic and
courageous. She's known
for her inquisitive nature,
probably acquired from
her father, a detective on
the New Orleans Police
force.

Henri Dijon is a gruff old
souihem-stvle colonel.
He's wealilty. eccentric
and reclusive. He live.s

alone except for his

servants: jeeves. Celie
and Fifl, and his pets. He
was wounded while
serving with distinction

in theSpanish-American

Lillian is Laura's college-

classmate and the
Colonel's niece. Her
personality cun be
described as extroverted

and rebellious. She
drinks, smokes and dates
several voung men. She
dresses in the style of the

1920’s flapper.

(ilorm Swansong

Lillian's mother and the

whimpery. whiny nature.

You can usually catch
her in a rather tipsy state,

and she gives the
impression of being
quite helpless.

Gertie is the widow of the

Coltmcrs younger
brother. .She's known as
money grubbing,
snobbish and bmsy. She
has a fondness for’

jewelry. . . especially

Gertie's daughter and the

Colonel's niece. An
a.spiring actress. Gloria
enjoys the glamorous
Hollywootflife-siyle,
She's a beautiful

E
latinum blonde, and
)ves money, jewelry

and rich boyfriends.



Clarence Sparrow

Rudy is Gertrude’s son,
Glona's brother and ihe
Cuiunel's nephew. He
eivcs ihc impression of
being a liule too slick.

Rudy is known as a
gambler, a womanircr
and a lush. They say he's

never worked an honest
day in his life.

Clarence is the Colonel's
aitomev. He manages all

of (he Colonel's busmess
affairs and accounts. He
seems rather sneaky, and
it is said that he lusts after
ihcCoInncrs money.

Dr. Feels is the Colonel's

long lime personal
physician. He is known
for his lecherous ways,
and his questionable
medical practices.

Jeeves

Jeeves is the Colonel's
tall, silent butler. Very
imposing and solemn,
he s not terribly friendly

or helpful. What i$ he
really after''

Fifi is the Colonel's sexy
French maid. It is

rumored that she and the

Colonel are involved in a
relationship of a
somewhat more than
domestic nature. Most of
the family are of the

opinion inat Fifi is using
the Colonel to get at his

money.

Celie is the Colonel 's

cook. She is quite
superstitious and
somewhat reserved, but

she can he friendly and
helpful if approached
cautiously, ft is said that

she dabbfes in voodoo.





I. II.LI AN; Laura. I've ju«t received an invitation la visit my Uncle Henri's esiale for a I'amily

reunion this weekend.

LAURA: (seeminKfy absorbed in her That sounds nice. Lil. You must be soescited.

I.II.I.IAN: Yw. I suppose I am, (looks slightly puzzled, then herface suddenly lights up)

.Maybe you'd like to come alonjt! Uncle Henri's mansion is on a private island, right in the

middle of the bayou. Someone like you should find it fascinating'.

LAURA; I don't know. Lillian. I really should study.

LILLIAN: Oh, come on Laura. It’ll be funf

(pause)

LAURA: (lotiking up and closing her hook) Well. I'supposc it won't hurt. At any rate it should

be more fun than reviewing for my biology exam.

LILLIAN: Oh, we re going to have such a time. You won’t regret it. Laura!

ACT I

SCENE I

Scene: Day. Campus commons, Tulane
Vniversity in Sew Orleans, Ijtaisiana in the

year I92S. during a class break. LAURA
BOW sits upon a bench, center stage,

reading a textbook. IJIJJAS PRVSE
stands near LAURA, also center stage.

SCENE 11

Scene: Night. A dark and misn bayou

.

LAURA andULUAN skim through the

gloom aboard a small skiff. A tall and
silent BIACKMAN pilots them. The
silence is broken occasionally by the eerie

cry ofa nighi bird. Finally theform ofa
grand house becomes discernible through
the dense trees. The skiffcomes to a hall

at a small dock, and the girls disembark.

Wilhoul a word, the BLACK .MAN turns

the boat around and is quickly lost in the

dark mists ofIke bayou. lAURA watches

until she can no tongersee him:



SCENE III

Scene: An island in Ihe swamp, on the

unkempi grounds ofColonel Dijon ’s estate.

An ominous looking, run down old mansion
is visible in Ihe background. LAURA and
ULUAN are walking toward the house.

LAURA looks around continuously, as ifshe

expects something tojump out of the

shadows. Shejumps when LILLIAN speaks.

LILLIAN: Well, what do you think. Laura?

LAURA: Icluiches her chest, then seems ic

catch herhreaih) It’s not exactly what I

expected ilooks anuinJ), but it looks interesting, all right (shivers).

.

{Pause as the girls walk in silencefora moment.

)

LILLIAN: Uneic Henri was a colonel in the .Spanish-Atnerican war. you know, In fact, he still

prefers to be called Colonel Dijon. 1 don’t call him that, though -- to me he's my dear old

Uncle Henri,

(LILLIA-N/whsw, looks wistful, as ilioiigh recalling fond memories.)

LILLIAN: He's a peculiar old bird, though. He covets his privacy and detests being bothered.

That's why he bought this place {gestures about them). When I was a little girl, he would

invite me to visit him here in the summers. Looking back, it seems that 1 was the bnly one in

the family that he really caretl aNtut. Thai's why I'm puz^led about this ‘family reunion'. 1

never would have expected a family gathering at Uncle Henri's.

SCENE IV
Scene.' The large front porch of the Dijon

mansion. LILLIAN andLAURA stand

center stage before aa immense door. On the

door are two huge door knockers.

LILLI.AN: {reachesfor one of the door

knockers, giggles) Kinda creepy, isn’t it?

(LILLIAN brings the door knocker down
with a loud BANG! and again BANG! A
short pause, then the door creaks open to

revealJF.EVES. the tall gaunt butler.)

JEEVES: {in a deep', imposing voice) Yeeesss?

(LAURA gapes at Iheformidable butler)

LILLIAN: {smiling) Jeeves, it's me. Lillian . . . don't you remember?

JEEVES; Ohhh. yesss. -Well, everyone else has arrived and they're assembling in the dining

room. Please come in and join them.



(JEEVES steps aside and gesturesfor the m-o girls to enter. LAURA and LILLIAN proceed

into the house.

SCENE V
Scene: The dining room of the Dijon

mansion. A fire is ablaze in thefireplace,

upstage center. An enormous dining table,

splendidly set, occupies center stage.

Seated at the table art LAVRA

:

ULUAN; ETHEL PRUNE, LILLIAN’S
mother; GERTRUDE DIJON, widow of
the COLONEL '5 late br^er; GLORIA
SWANSONG. GERTRUDE'S daughter

and the COLONEL'S niece; RUDOLPH
DIJON. GERTRUDE S son, GLORIA 'S

brother and the COLONEL’S nephew;
CLARENCE SPARROW, the

COLONEL'S attorney; and DR. WILBUR
C. PEELS, the COLONEL'S long time personalphysician. During dinner, (AURA is introduced

to the other guests. They are largely uapleasant. and bicker amongst themselves throughout the

meal. At last, dessert is served.

{Enter COLONEL DIJON in a wheelchair. He is being aided by FIFI. his sexy blonde maid.

She parks him at the head of the long table.)

COLONEL DIJON: {nods tersely, and speaks in a gruffvoice) I’m glad to see that you're all

here. I'm sure you're all wondenng why I've asked you.

{jtause, as DIJON dears his throat)

COLONF.L DIJON: As you know. 1 am a very wealthy man. Unfonunaiely, I believe my end

is near, and so I have decided to bcv|ueath my many millions to each of you. .

.

{pause, as DIJON appears to notue LAVRA for the first time)

COI.ONEI, DUON: Who are you. dear'.’

LAURA: (flerv«Ms/y) Oh. I beg your pardon sir. my name is Laura Bow - I'm just a friend of

Lillian's. Would you like me to leave the room while you talk about this'.'

COLONEL DIJON: No. no. just sit where you arc. I'm nearly llnished. Now where was I'?

Oh. yes. AHEM! As I was saving, each of you here, except for Miss ... ah. Bow is it? Yes,

well you'll all inherit EQUALLY upon my demise. If any of you should expire before I do.

then your share will be divided equally among the surviving parties.

(pause, as DUON SH/revi his guests, apparently letting his words .sink in. The guests look at

one WHither suspiciously .

)

COLONEL DIJON: I'm tired. Pifi. Help me to my room (looks again at the assembled

guests), if you’ll all excuse me. I'm going to retire for the evening. I will see you all in the

morning. Have a pleasant night.

(DIJON signals FlFl, who tuens him around and wheels himfrom the room. The group sits in

silence until DUON is gone,)



GERTRUDE; Can you believe that?

RUDY; The old goal.

GLORIA: I'm surprised he didn't Iry to take h with him, he's such an old skinflint!

RUDY: I don't think YOU deserve any mwiey!

GLORIA; Speak foryoursclH

CLARENCE: How much do you Ihmk he's got?

WILBUR: Well. I know what I'm going to do with MY share!

CLARENCE: YOUR-SHARE?! I bet the old codger outlives YOU!

GERTRUDE: I wonder how sick he is?

ETHEL. Do you think he'll go soon?

LILLIAN: (sianding ahriiplly) I've hud enough of this! Laura and I will retire lo our room

{exit LAURA and LILL1A\>

SCENF. VI
Scene: Guesi room shared by UU.IAS
and LAL'RA. Two beds occupy upstage
right and downstage right. A small couch
sits downstage center and near it, an
armchair. A large portrait ofCOLONEL
DIJON hangs upon the wall above the

fireplace, upstage center. LILLIAN opens
her suitcase and rummages through it.

LAVRA surveys the room.

LILLIAN: Will ytiueJicuseme, Laura?

I'm going to freshen up u bit. Please

(LILLIANflounces out ofthe room, leaving Laura alone. LAURA wanders around the room

for a .short time, e.xamining closets, drawers and various objects, then ventures out into the

enormoiistnansion.)

ON WITH THE SHOW ..

.

As usual. Laura's curiosity has gotten the better of her. In this case however. I'm

afraid she may beina littie over her head. Let’s join her now. before the real fun

begins. Maybe we’ll be in time to be ofsome assistance to her as she attempts to

solve the mystery of . . . THE COLONEL’S BEQUEST!

make yourself at home and feel free lo explore!

LAURA; Thank you Lil. I may do Just that.
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HOW TO READ THIS MANUAL
Throughout this manuai we will be using the following ways of representing informaiion;

MENU COMMANDS will be capitalized.

Example: SAVE. RESTORE. QUIT. PAUSE

Typed commands will appear as bold type.

Example: ‘type; ask lillian about ethel'

‘type; cd \sierra‘

Portions of the command line not meant to be typed will not appear in bold type. For

example, in the line 'type; cd \sierra‘. ‘type;‘ should not be typed.

[Example text) and [Keystrokes) will appear in brackets setting them off from the

surrounding text. The brackets ((]) are not keystrokes and should not be typed.

Example: [object], [character]. [Spacebar]. [Tab). [PageUp]

Two or more keys that should be pressed at the same time will be separated by a hyphen

(•) This hyphen is not a keystroke, and should not be typed.

Example: ‘Press [Ctrl-lj to view your inventory.’

if a space appears between parts of a command, it is meant to be typed.

Example: ‘type cd vsierra’ (the space between cd and Vsierra should be typed as pan of

the command.

The term ‘diskette' is used to refer to either 5.2.V or 3.5" data storage disks.

ALL SYSTEMS
Pl.F.ASF. NOTE: It is important that you view the README file on your game disk as it

may contain important information and instructions that were nut available at the time

the documentation and other materials for this game were printed. Failure to review the

README file before installing the program may result in unexpected consequences

during the installation and/or running of the program.

MS-DOS README INSTRUCTIONS
To view ihe README file from DOS. type: readme. If the file is longer than one screen, Use

[Page Up|/|Page Down) to scroll through the File one screen at a time.

ATARI ST README INSTRUCTIONS
To view the README file from the desktop, double-click on the README. D(X? icon. You

will see a message box with choices for SHOW. PRINT, and CANCEL. Choose SHOW to



view the file one screen at a lime. Press [ENTER] to sec ihe next screen. Choose PRINT to

print the file. Choose CANCEL to escape the message box.

AMIGA README I>STRLCTIONS
Insert WoricBench disk into drive DFO; and turn on your system. Double-click on the CLl icon.

Users with one drive: Copy the ‘type’ command into your RAM disk. See your Amiga

owner’s manual for instructions. Insert game disk I. Type: type readme.

Users with mure than une drive: Insert WorkBench in drive DFO:. Insert game disk I in

drive DFl:. Type cd DFl;. Type; type readme.

GETTING STARTED: DISKETTE DRIVES
It is always advisable to make back-up copies of your master program diskettes to increase the

life of the masters and guard against accidents. Follow your computer’s instructions to make

copies of all game diskettes.

Even if you will be playing from a hard disk, you may also want to format a blank disk for

saving games. Follow your computer's instructions to format a blank diskette and keep it

handy for saving your game as you play. For some helpful tips on saving games, see the

‘Saving Your Game' (Page 9) and 'Interacting withTfte Colonel's Bequest' (Page 9) sections

of this manual.

When installing your program, you may be prompted to insert a ’Drivers' disk. If you receive

thi.s prompt, please examine your disks and insert Ihe disk marked ’Drivers’ and press

[ENTER], so that the appropriate drivers will be loaded. Some games do not include a separate

'Drivers’ disk.

MS-DOS

INSTALL THE GAME
Place the back-up copy you have made of disk 1 into your diskette drive. Type the letter of the

drive you have placed the diskette into followed by a colon (for example: :), and press

[ENTER], Type; install and press [ENTER].

Answer the onscreen questions using the up and down (Arrow| keys to highlight your

selections, then press [ENTER] to select. You will be asked if you wish to install the game on

your hard disk. If you do not wish Ihe game to be installed on your hard disk, press [ESC] to

skip this step. If you want to install the game on your hard disk, enter the letter designation of

your hard disk (usually C) and follow the prompts.

Please note: Even ifyou install to a hard disk, the install procedure will write a file

named RESOURCF..CFG to disk 1. For the installation lo be completed correctly. DISK

1 MUST NOT BE WRITE PROTECTED. No other Files on disk 1 are written or changed

by the install command.



LOADING INSTRUCTIONS
Al'tercompleting ihe INSTALL procedure:

From diskettes:

1. Place Disk 1 into ihc A drive.

2 . Type: a: and press lENTER).

3. Type: sierra and press |ENTER].

From hard disk:

1. From yourrooi direciory, type; cd \siem and press [ENTER).

2 . Type: cb and press (ENTER).

SAVING GAMF.S TO DISKETTES
PLEASE NOTE: If you 're ptaying From dlskenes, you miisl have a separate formatted

diskette ready before you can save a game. Since each diskette can only hold a limited

number of games, we recommend that you have more than one formatted in order to

assure adequate space for save game storage.

1.

Choose SAVECAME from ihe File menu.or press the [F5| key. The Save Game menu

will appear.

2.

Usc your [Tab] key to choose CHANGE DIRECTORY. Backspace or press |Ctrl-Ci to

dear the command line.

3. Type the letter of the drive you are using for saved games, followed by a colon

(Example: a:) and pre.ss )ENTER|.

4. Type the name of your saved game and press [ENTER) to complete Ihe SAVE GAME
procedure. If your disk for saving games is full, you may reformat it (this will erase the

saved games on the disk) and use it over, or use another formatted blank disk.

SAVING GAMES TO HARD DISK
If you choose to save games to the hard disk, the program will automatically try to save to the

game’s own directory. If you run out of space for saving games, try one of the following

alternatives:

1. Save additional games to a diskette.

2. Save games to a different direciory by using your [Tab) key to choose CHANGE
DIRECTORY from the Save Game menu (inside Ihe game).
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3. Delete the saved games and the save game direcioiy from your hard disk by following

DOS insiniciions (outside the game). The program will create a new directory for your

games.

4. Create a new hard disk directory from DOS. using DOS instructions.

ATARI ST

LOADING INSTRUCTIONS
Note: Ifyou are using an Atari 520 ST without memory expansion, turn off all desk

accessories (rename ACC extension ACX) before running your Sierra game.

1. If you are playing the game from diskettes: place Disk I in drive A. open the disk by

double-clicking on its icon. Stan the game by double-clicking on SIERRA.PRC.

2. If you arc playing the game from a hard disk: open the disk by double-clicking on its

icon, then open the game folder by double-clicking on the game folder icon. Sian the

game by doublc-clicking on SIERRA.PRO.

HARD DISK INSTALLATION
Please note; More than S 1 2K of memory is needed to run Sierra games on your Atari ST hard

disk.

1. Open the hard disk by duuble-clickmg on its icon.

2. Create a game folder by choosing NEW FOLDER... from the File menu. Open the

new folder by double-clicking on its icon.

3. Place Disk I in drive A;.

4. Copy the game disk into the new game folder by dragging the drive A: icon into the

window you opened in Step 3.

5. Repeal steps 3 and 4 for each of the other game disks.

6. Put the master disks away in a safe place.

CHOOSE A MUSIC DEVICE (Optional)

Your Sierra game is initially set up to play music and sounds through the Atari ST's internal

speaker. If you have one of the supported MIDI synthesizers, you may run the MUSIC
program to have the game play music through the synthesizer.

1. Open the game disk/lblder by double-clicking on its icon.

2. Run the MUSIC program by double-clicking on the MUSIC.PRG icon.



3. Select MUSIC DEVICE from the Options menu.

4. Select your synthesizer (or ATARI ST IMTERNAL SOUND) by clicking on the

appropriate button, and click on OK.

5. Select INSTALL GAME from the File menu. This will replace the RESOURCE.CFG
file on your disk.

Please note: It is important to turn on your synthesizer before starting the game.

AMIGA

INSTALLING THK GAMK
NOTF.: RF.NAMF. your copies of all game disks to remove the words 'COPY OF' from

the disk name. If the words ‘COPY’ OF' are nut removed from the disk names of ALL the

copies, the system will continue to ask fur the original disk, and will not run the game.

1. Boot your system with WorkBench. and insert Disk I of your Sierra game.

2. double-click on the disk icon, then double-click on the INSTALL icon.

3. Follow the onscreen prompts, choosing your selection with the mouse hy clicking

once on the item.

4 . You will be asked if you wish to install the game on your hard disk. If you do not wish

the game to be installed on your hard disk, select NO. If you want to install the game on

your hard disk, select YES.

5. Using your mouse, select which hard drive you wish to install the game onto.

6. Follow the onscreen prompts to complete the installation.

LOADING INSTRUCTIONS

From Floppy Diskettes:

1 . If you have less than 1 megabyte of memory for your Amiga, turn your system off and

disconnect any external drives.

2. Insert Disk I into drive DFO:

3. Turn on your system.

From Hard Disk:

1 . Load WorkBench and double-click on your hard disk icon.
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2.

Double-click on the SIERRA GAMES drawer.

3. Click on the drawer for the desired Siena game.

4. Click on the game icon.

ALL SYSTEMS

PLAYING THE GAME
MOVING YOUR CHARACTER
You may move your character on the screen with the [Arrow] keys, the numeric keypad, or the

mouse. To halt your character's steps with the keypad, press the number S. or press the last

used direction key again. [>o not attempt to move the character by holding down the

direction key. This will cause the character to start and stop continuously, resulting in

very slow progress.

Using the mouse, position the anow to where you want the character to move, then click the

left mouse button.

_Q _
" iiSQiQ

GAME SPEED CONTROL
At times it may be u.seful to slow down the speed of the game animation in order to negotiate a

tricky section, or observe something more carefully. In The Colonel's Bequest, speed is

controlled by the H and [-] keys, or by selecting a choice from the Speed menu, using the

mouse or [Arrow] keys.

MENUS
The Menu Bar in The Colonel's Bequest is not visible during play. When you press [ESC], the

Menu Bar will appear at the top of your screen with several menus which can be opened to

show the command choices available to you.

KEYS TO USE IN THE MENUS
Use the left and right [Arrow] keys to open a menu, and the up and down [Arrow] keys to

highlight items within a menu. Press [ENTER] to select a highlighted command. Press [ESC]

to return to the game without choosing a command.

00!
OE3L-
OLO'

I \ Stop

* SE
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SHORT CUTS FOR COMMON COMMANDS
You can use function and control keys to short cut many common commands.

|F1] Help

[F2] Toggle sound on/off

|F3j. ISpacebarl Repeal previous command

|F5| Save Game

|F7] Restore (saved) Game

|F«»| Restart Game (from beginning)

ITabl Inventory

[ESC] Show Menu Bar. Pause Game

(Ctrl-C| Cancel typed command line

(Ctrl-Ij Inventory

lClrl-P| Pause Game

ICtrl-Q] Quit Game

l+l Increase Speed

[-1 Decrease Speed

1=1 Normal Speed

[Ctrl-V| Change Volume

[Shin-Click] Look at an object (see below)

SHIFT-CLICK
SHIFT-CLICK is a feature which will allow you to look at a person, place or object using your

mouse. Place the mouse arrow on the desired person, place or object, then hold down the

[ShiftI key and press the mouse button. You will now receive a descriptive message.

* Please note: Multi-button mouse users should use the RIGHT mouse button and need not

press (Shift].

USING YOUR TAB KEY
While playing Sierra games, your (Tab) key will perform two major functions. You will use it

to review the items in your inventory, and also (if you're not using a mouse) to select options

from certain menus. The following menus will require the use of the [Tab] key lor highlighting

menu options:

MENU CHOOSEFROM
{.Opening

2. Restart Game

Yes, No

Restart. Continue



3. Quit Game

4. Save Game

5. Restore Game

6. Death Window

Quit. Continue

Save. Change Directory Cancel. Replace

Restore. Cancel. Change Directory

Restore. Restart. Quit

USING THE MOUSE (optional >

Your mouse will be useful to you in moving your character, and in learning about your
surroundings. To moveyour character using the mouse, position the arrow to where you want
the character to move, then click the mouse button. If your mouse has more than one button,

use the left button.

EXAMPLES OF COMMON COMMANDS
Many characters in the game will have information of one kind or another for you. To talk

with a character, type: talk to (character!, ask (or tell) Icharacter] about Icharacieror object].

For example: talk to gertie. tell the colonel about lillian orasklillian about the jobjecl]. Try

different approaches. 'Show' an object to someone, and they may give you valuable

information. 'Asking' a character about something may evoke a different response than

'telling' them.

You may encounter objects you need along the way. To lake an object, type: take (or get) the

lobjecl] for example: take the note, ui gel the key.

Pay close attention to detail.s. To look closely ot objects, type look at the [object], for example:

look at the table You can also use the IShift-Click) feature described on Page 7.

You will need to use the objects you acquire as you explore. You can try different things such

as typing; use the lobjecl]. or give the (object) to ]charactcr| or show {object] to Icharacter].

Different approaches to a puzzle may bring about a different outcome.

RETYPING COMMANDS
If you wish to repeat a command, select RETYPE from the Action menu or press the

ISpucebar] or [F.3|.

INVENTORY
If you wish to sec the items you arc carrying, select INVENTORY from the Action menu, or

press [Ctrl-I| or [Tab]. A list of the items you arc carrying will be displayed. To view an

object, click on its name with the mouse, or use the [Arrow] keys to highlight the name and

press [ENTER], Press [ENTER] again, select OK or press [ESC] to resume play.

PAUSING YOUR GAME
If you wish to pause the game, select PAUSE from the Action menu, or press ]Clrl-P] or

|ESC]. Press [ESC] or [ENTER] to resume play.



SAVING YOLR GAME
If you wish lo save your game, select SAVE from the File menu or press [F5], To allow for

errors in judgement and creative exploration, we recommend that you frequently save your

game in progress, and that you save several different games from different points as you play.

You will always want to save your game before encountering potentially dangerous situations.

You should also save your game after you have made significant progress.

PLEASE NOTE: Ifyou’re playing from floppy disk.s. you must have a separate

formatted disk ready before you can save a game. We also recommend that you create

several directories or folders on your save game disk in order to assure adequate space

for save game storage.

If you choose to save games to your hard disk, we suggest that you create one or more save

game directories or folders on your hard disk. See your computer's instructions for creating

directories or folders.

You may name your saved games using standard English phrases. For example, if you arc

standing on a sandy beach, you might call your game standing on a sandy beach, or simply

beach.

RESTORING YOUR GAME
Select RESTORE from the File menu, or press |P7]. You will be prompted to select the game

you wish to restore. (On a single drive system, you will be prompted to insert your save game

disk). Highlight the desired game and select RESTORE. If the game you wish to restore is in a

different directory, select CHANGE DIRECTORY.

QUITTING YOUR GAME
[f you wish lo slop playing, select QUIT from the File menu, or press |Ctrl-Q|.

RESTARTING YOUR GAME
If you wish in restart your game at any time during play, select RESTART from the file menu,

or press the [F9] key. The game will begin again in the guest room shared by Lillian and Laura.

INTERACTING WITH THE COLONEL’S BEQUEST
You can generally interact with the game by typing simple commands consisting of as little as

a noun and a verb. For instance, the command gel into the car can be shortened to get in car.

Unless otherwise instructed, follow all commands with lENTER),

The Colonel's Bequest will understand many common verbs. Here arc some you might try:

LOOK
GET
READ
LOAD
TALK
PRY

CLIMB
PUSH
PLAY
TELL
USE
ASK

OPEN STAND
CLOSE GIVE
PULL EXAMINE
SHOOT JUMP
MOVE TAKE
SHOW
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A message window will appear each time you enter a command, and at other times during the

game. When you have read the message, press [ENTER] to remove the window and resume

play.

TAKE NOTES as you discover clues and information. Record anything you think might be

important. Make a note of each area you visit, and include information about objects found

there, and dangerous areas nearby.

DRAW A MAP as you progress through the game. If you miss an area, you may miss un

important clue!

WATCH THE CLOCK. As you progress through the game, a clock will periodically appear

on your screen. Take note of the event and location when this occurs. This will help you to

keep track of your progress.

LOOK EVERYWHERE When you enter a room for the first time, you will receive a

message on your screen describing the room. When you visit the room again you will need to

type: look around or look room to gel the description. Look closely at all objects you

encounter,

EXPLORE each area of the game very carefully, and be on the lookout for clues and hidden

places, Search every area of the mansion and the grounds surrounding it. Re-visit un urea

frequently, and make note of anything that has changed. Something may occur in an area while

you arc elsewhere.

TALK 10 everyone you meet, but use discretion! Some characters will be friendly and helpful;

they may give you valuable information and advice. Others may mislead you. Try various

approaches in dealing with others. If talking to them or asking them questions yields few or no

results, show them something interesting you have found. They may have a comment that will

help you.

LISTEN closely lo conversations. Useful information will pass between the other characters,

and you'll want to pay attention to details chat may help you with your investigation.

PICK UP anything that isn't nailed down. You will come across a number of objects that may

be of use to you later. You can see an inventory of items on hand by pressing the [TAB] key at

any lime.

USE the items you have picked up to solve problems in the game, or to help you to make

progress and discover more clues.

BE CAREFUL, and remain alert at all times - disaster may strike in the most unlikely of

places.

SAVE YOUR GAME OFTEN, especially when you are about to try something new or

potentially dangerous. This way. if the worst should happen, you won'lhave to start all over
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again from the beginning. Ii is probably best lo save at least one game in each act of The

Colonel's Bequesi. so you will be able lo relum to a desired point in the game. In efl'ecU this

will enable you to travel backward through lime and do things differently if you wish. After

you have restored a saved game, take note of the time of night Refer to your notes; you will

need to repeat .some actions to insure that other events will take place as they should.

DON’T GET DISCOURAGED. If you come to an obstacle that seems insurmountable, don't

despair. Spend some time exploring another area, and come back later. Every problem in the

game has at least one solution, and some have more than one. Sometimes solving a problem

one way will make it harder to solve the next, and sometimes it will make it easier. If you get

stuck, you might try restoring a saved game from an earlier point, then choosing a different

path. If all else fails, you can buy The Colonel's Bequest hint hook from the dealer who sold

you the game, or you can order directly from Sierra On-Line by calling (800) 326-6654.

BRING ALONG SOME HELP. You might find it helpful (and fun) to play the game with a

tnend. Two (or more) heads arc better than one at interpreting clues and solving problems.

NEED A HINT?
If you find yourself 'a little stuck* while playing a Sierra game, try the following ideas:

1. If you have a modem, you can talk to the Sierra Bulletin Board through the following

number:

(209) 683-4463

Our sellings are 300. 1200 or 2400 Baud; 8 Data; N Parity; 1 Stop Bit. Our sysop will be

happy to help you.

2. Many other bulletin boards also provide hints lo many of our games.

A. CompuServe; Go into the Gamers Forum (GO GAMERS) or write E-Mail to

76004,2143.

B. Prodigy: Write E-Mail to 'HTWS90E'. or go to the PC Club and enter the

adventure games forum (Jumpword: PC CLUB).

C. PCLink; Select PCLink Plus, enter Publisher’s Connection, select Publishers

Forums, then Sierra On-Line. E-Mail may be written to the User ID ‘Sierra On Li'.

D. AppleLink: Select the KEYWORD option from the ’Goto' menu, and type:

Sierra. E-Mail may also be written to the User ID ‘Sierras’.

E. GEnie: From the main menu select 10 (Games), then select 1 (Games Round

Table). Select I (Games Bulletin Board), and type sel 22 at the 'T prompt. This

will lake you into the Sierra On-Line area.

For more information on these BBS lines, you can call these toll-free numbers:

1 . CompuServe (800) 848-8199

2. Prodigy (800) 822-6922

3. PCLink (800) 458-8532
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(800)227-63644. AppleLink

5. CEnie (800) 638-9636

For more information on the Sierra BBS. call;(209) 683-8989

3. The magazine Queslbusler'sJourntil is a helpful source of many game hints,

4. Your local software dealer may carry our hint bodts. or may be willing to order them

for you.

5. If you are unable to obtain a hint book through a dealer, you can order one directly

from us. Call (800) 326-6654 to place your order with a Visa. IVlasicrCard or American

Express card, or write Sierra On-Line Inc.. Order Depanmem. P.O. Box 48.5.

Coarsegold. CA 93614.

6. If the hint book is not yet available for the game you are playing, call our automated

him line at (9(X)) 370-KLUE to receive a him. NOTE; California residents, please dial

(900) 370-5113.

THIS SERVICE IS AVAILABLE 24 HOURS A DAY. THE CHARGES ARE: 75

CENTS FOR THE FIRST MINUTE AND 50 CENTS FOR EACH ADDITIONAL

MINUTE. IF YOU ARE UNDER 18 YEARS OF AGE. YOU MUST HAVE A

PARENTS PERMISSION TO CALL . THE CONTENTS OF ALL MESSAGES
ARE SOLELY THE RESPONSIBILITY OF SIERRA ON-LINE. HINTS WILL
NOT BE GIVEN ON OTHER SIERRA TELEPHONE LINES.

WALKTHROUGH
Please note: In order to understand the object of The Colonel's Bequest, it is very important

that you view the opening cartoon at least once.

HOW TO USE THE WALKTHROUGH. Onscreen movement: north = up: soulh = down;

west = left; sail = right. The walkthrough takes you through several game screens. Move your

character around the screens to the suggested places, and type in the words that appear in btdd

type,

WARNING: The following information is for beginning adventurers only. The contents

include answers to some game puzzles and hinLs that experienced adventurers may not wish to

see. Continue reading only if you are having difficulty getting started with The Colonel’s

Bequest.

As the opening cartoon ends, we find Laura and Lillian in their shared guestroom. When

Lillian excuses herself and exits the room, you will have control of the game. The most

important thing to do at this point is to examine your surroundings.

Walk north to the fireplace. Notice the portrait of the Coloiwl above the mantle.

Type: look at the portrait [ENTERl
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C) Press lENTER]

D) Respond to DOS prompts.

Now you should create a CONFIG.SYS file on your Sierra Bool Disk, with a riles=20

statement. Follow these instructions to create this file:

A) Type: a:[ENTER|

B) Type; copy con ct»nfig^ys[ENTER]

C) Type: nie.s=20| ENTER)

D) Press IF6][ENTER|

You should see the message: ‘
I File(s) copied'. You will now have to re-bool your computer

with your new Sierra Boot Disk in the drive. Turn your computer ofTlhen on. or press
IClrl-Alt-Dcl).

If this does not clear the above messages, call (209) 683-8989 for technical help. Our technical

staff will be happy to help you.

TECHNICAL HELP (ALL SYSTEMS)

Technical assistance is only a telephone call away. Call (209) 683-8989 for convenient,
pcrson-io-pcrson service, or if you prefer, you may request assistance by mail. If you choose to

write to us with your request, please stale your computer type and the nature of your problem.

If you find that you need to send for replacement diskettes, send the original disk 1 in the size

you need (3.5" or 5.25") to;

Sierra On-Line

P.O. Box 485

Coarsegold, CA 93614

Attention: RETURNS

to include a note stating your computer type, and the

:

of diskette you need (5.25" or

We will gladly replace your program free of charge for the first 90 days of ownership
(please enclose a copy of your <»ted sales receipt with your request). After 90 days
incre is a $5.00 charge for 5.25

' diskettes, and a $I0.0(| charge for 3.5" diskettes.
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